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General Format and Layout Specifications  
  

File Type  

Mystery Publishers accepts manuscripts in soft copy (MS Word—.doc, .docx, or .rtf) via email 

only. This way it is easier for the editor and the writer to review the document and track changes 

during editing.  

NOTE: If the writer has elected to utilize Mystery Publisher’s editorial services during the 

publication process, the writer will need to have access to view editorial suggestions and revisions 

in Microsoft®.  

  

Parts of the Book  

The manuscript should be submitted in one continuous Microsoft Word document. Below are the 

different parts of a book that can be included in the manuscript:  

  

Front Matter:   

Front matter appears before the main text and introduces the book to readers. The 

following comprises front matter in the correct order: 

  

Endorsements: (if any)  

Half-title page: The half title (on page i, the first recto) normally consists only of 

the main title. The subtitle is omitted, and the author’s name does not appear. The 

verso of the half title (page ii) is usually blank but may contain text or an 

illustration, called a frontispiece.  

Card or series title page: List any of your previously published books by title 

from first to most recently published. A common way to begin this page is “Also 

by [author’s name] …”  

Full-title page: The title page (p. iii or, if a two-page spread, pp. ii– iii) presents 

the full title of the book; the subtitle, if any (note that there should never be more 

than one subtitle); the name of the author, editor, or translator; and the name and 

location of the publisher. If the type size or style of the subtitle differs from that of 

the main title, no colon or other mark of punctuation is needed to separate them.  

Dedication: It is not necessary to actually include the words “Dedicated to” in a 

dedication. A statement like “For Casey” or “To my mother” is more appropriate.  

Epigraph: An epigraph is a quotation that is pertinent but not integral to the book.  

Table of Contents, List of Illustrations (if illustrations are included in 

manuscript), and List of Tables (if tables are included in manuscript)  

Foreword: A foreword is usually a statement by someone other than the author, 

sometimes an eminent person, whose name may be carried on the title page (e.g., 

“With a Foreword by John Quincy”).  

Preface: The author’s own statement about the work is usually called a preface. 

Material normally contained in an author’s preface includes reasons for 

undertaking the work, method of research (if this has some bearing on readers’ 

understanding of the text), acknowledgments, and sometimes permissions granted 

for the use of previously published material.  
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Acknowledgments (if not part of the preface): If the acknowledgments are long, 

they may be put in a separate section following the preface; if a preface consists 

only of acknowledgments, the title should be changed to “Acknowledgments.” 

Acknowledgments are occasionally put at the back of a book, preceding the other 

matter. In multivolume works, acknowledgments that apply to all volumes need 

appear only in the first volume. Should they vary from volume to volume, separate 

acknowledgments may be included in each.  

Introduction (if not part of text): A substantial introduction by someone other 

than the author is usually included in the front matter, following the 

acknowledgments; however, if it is not more than three to five pages, it may more 

appropriately be called a foreword and placed before the preface. Material about 

the book—its origins, for example—rather than about the subject matter should be 

included in the preface or in the acknowledgments. Most introductions belong not 

in the front matter but at the beginning of the text, paginated with Arabic numerals.  

(List of) Abbreviations or Chronology: Other items that may be placed either in 

the front matter or, sometimes more suitably, in the end matter include a list of 

abbreviations, a publisher’s note, a translator’s note, and a note on editorial 

method.  

Prologue — In a work of fiction, the prologue sets the scene for the story and is 

told in the voice of a character from the book, not the author’s voice. 

Second Half Title — If the front matter is particularly extensive, a second half 

title (identical to the first) can be added before the beginning of the text. 

 

Book Block  

The main text, or the body text, is the core of the manuscript. It should have the following:   

  

Introduction: The introduction describes something about the main text that the 

reader should know before proceeding to read the book.  

  

Chapter layout: Each chapter begins at the top of a new page. The first page of 

each new chapter will begin directly following the last page of the previous 

chapter unless specifically requested that all new chapters begin on the recto 

(right-hand) page of the book.  

  

Epilogue: An epilogue is a brief concluding section, often addressed directly to the 

reader in a work of fiction. Most epilogues continue the story years later or update 

the reader on a certain character’s whereabouts. Please do not use a chapter 

number for this section.  

 

Afterword: The afterword is also a brief concluding section, often used in 

nonfiction works. It does not need a chapter number. For example, you may want 

to use the afterword to review the strategies outlined in the book and give advice.  

Conclusion: More extensive than an epilogue or afterword, a conclusion may or 

may not be numbered as the final chapter. The conclusion provides a summary of 

your ideas, concepts, and advice, leaving the reader with a clear understanding of 
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the major concepts presented in the book and some guidelines on what to do with 

that information.  

About the Author: This is a short biography at the end of the main text that 

summarizes (1) any expertise the writer has have in the field in which s/he is 

writing, (2) any previous books that the writer has published, and (3) a brief 

summary of where the writer currently lives, with whom they live, and what type 

of work they do.  

  

End matter  

Use the list of common book block parts below to ensure that the parts of the end matter 

are in the correct order.  

  

Appendices: An appendix includes any data that might help clarify the text for the 

reader but that would have disrupted the flow of the main text had it been included 

earlier. Such items include a list of references, tables, reports, background 

research, and sources (if not extensive enough to be included in a separate section).  

Notes: If the main text requires notes to amplify or document certain passages 

throughout the text, arrange the notes by chapter in a notes section.  

Glossary: A glossary comprises alphabetically arranged words and their 

definitions.   

Resources: Often, readers want to buy products or join organizations in the field in 

which the writer has written. A list of organizations and associations, 

manufacturers and distributors, Websites, and other sources are invaluable to 

readers.  

  

Bibliography or References: Both the bibliography and reference sections list the 

sources for works used in your book. Be sure to arrange the sources alphabetically 

by the author’s last name. For samples and guidelines on proper layout, refer to the 

APA Manual of Style.   

  

Index: The index is an alphabetically ordered list of words and terms used for 

referencing the text.  

  

  

Font type and line spacing  

For text in the body of the manuscript, Times New Roman, 1.5 spacing, 12pt Writer can request 

a different font or spacing to be used in the final book. Headings of the same level should be put 

in a uniform typeface, font size, and alignment throughout the manuscript.  

Example: (A manuscript might be organized in the following way)  

Chapter titles: Times New Roman, 24/22-point, center aligned  

First-level subtitles: Times New Roman, 18-point, left aligned  

Second-level subtitles: Times New Roman 15-point, left aligned  

Body Text: Times New Roman 12-point, left aligned 
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Use Courier in a portion of a book or article that you specifically want to look like 

a typewriter for some reason. It should only be in short bursts, though, since 

proportional fonts “flow” better. 

Line spacing 1.5 

NOTE: These specifications are for manuscript submission. They are different 

from house styles for publication. 

House styles for publication are: 

1. Serifs font typeface for print books – Garamond, Palatino Type, or 

Book Antigua.  

2. San Serifs for digital books – Helvetica, Franklin Gothic, Aerial, 

Trebuchet MS, or Candara.  

The writer may choose any different preferred style for their books. 

Manuscript length  

The manuscript should have at least 48 pages (8.5" × 11" pages), 10,000 words, or 22 poems.   

 

Page size  

Standard book trim sizes that Mystery Publishers publishes for print-on-demand set up are as 

tabulated below:  

 

Most Popular Trim Sizes 

 

5" x 8" (12.7 x 20.32 cm) 5.25" x 8" (13.34 x 20.32 cm)  5.5" x 8.5" (13.97 x 21.59 cm) 

 

6" x 9" (15.24 x 22.86 cm) 

 

More Industry-Standard Choices 

 

5.06" x 7.81" (12.85 x 19.84 cm)  6.14" x 9.21" (15.6 x 23.39 cm)  

 

6.69" x 9.61" (16.99 x 24.41 cm)  7" x 10" (17.78 x 25.4 cm) 

 

7.44" x 9.69" (18.9 x 24.61 cm) 7.5" x 9.25" (19.05 x 23.5 cm) 

 

8" x 10" (20.32 x 25.4 cm)   8.5" x 11" (21.59 x 27.94 cm) 

  

6" × 9" is the most common size for trade paperbacks as well as the most popular choice among 

most authors. If the writer is not sure what book size would best suit their work, s/he should spend 

some time at the local bookstore and identify the sizes of other books in their genre. The author 

should note that the above trim sizes are industry standard and guarantee expanded distribution 

for the book. 

  

Please Note:  Mystery Publishers prints paperbacks only. Hardcover may be made on 

special request by the writer.    
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Margins  

Margins are the white space that surrounds text on a page, including headers and footers, as well 

as the “gutter” space for the book’s spine. When a manuscript is converted from an 8.5” x 11” 

size document into a different size, such as 6” x 9”, the margins will change. Often times this will 

cause text to shift or lines to break differently from the original manuscript. The book designer 

can compensate for these changes, but this shift can cause issues if the writer has done extensive 

formatting to the manuscript. Margins can be set in two ways: 

  

Option A: (Best for novels, or books with all free flowing text)  

  

Format the manuscript on an 8.5" × 11" page with 1" margins all around (the default settings in 

Microsoft Word). During the production process, the manuscript will be formatted to the chosen 

trim size.   

  

Option B: Best for poetry or non-fiction books with tables, graphs, or images.  

  

The manuscript can be formatted so the margins will appear in the proofs. This option provides the 

exact area that can be printed. For example, a table spanning the entire width of the page in the 

default 8.5x11 setting of Word would be larger than the entire width of a 5x8 book. Here are the 

margins for our most common trim sizes:  

  

  5x8  6x9  8.25x11  

Top  2.25  1.75  1.00  

Bottom  2.25  1.75  1.00  

Left  2.38  1.88  1.13  

Right  2.38  1.88  1.13  

Header  2.00  1.50  0.75  

Footer  2.00  1.50  0.75  

Gutter  0.13  0.13  0.13  

  

  

   

  



 

Spaces and Breaks  

In the sections that follow, it is how formatting marks should appear on a correctly laid-out 

manuscript. There are three ways to view these formatting marks on the screen in Microsoft 

Word:  

  

1) Select the Tools option in your taskbar  

a. Then select Options   

b. On the View tab window that appears, under Formatting Marks, check All.  

2) Click the ‘pilcrow’ ( ¶ ) show/hide button on the toolbar.   

  

  

Body Text & Hard Returns  

In the main body of the manuscript, let text automatically flow from one line to the next and 

from one page to the next. Press Enter only at the end of each paragraph. Pressing Enter to move 

the cursor to the next line or page (known as a hard return) will cause spacing problems when 

your manuscript is formatted into its final book size.  

  

Incorrect:            Correct:  
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Paragraph indentation  

The first paragraph of each chapter or section should not be indented, based on industry 

standards. However, every subsequent paragraph should be indented:   

  

1) Select the Format option in your taskbar  

a. Then select Paragraph  

b. In the window that opens, under “Special” Select First Line and .5  

  

  
  

  

** Do not use the space bar or the TAB key to indent paragraphs, as this will throw off the 

layout of the final book.   

 

Offset (Blocked) text  

To present block quotations or to offset other text, such as journal entries or letters, use the 

indentation settings in your word-processing program. Select with cursor the entire paragraph 

you would offset. Then follow the following steps:  

  

1) Select the Format option in your taskbar  

a. Then select Paragraph  

b. In the window that opens, under “Indentation” section you can increase the Left 

and Right margins as you desire. This create the block effect  
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c. You may also wish to alter the alignment under the “General” section to 

“Justified” instead of “Left” for a better block effect.  

  

  

  
 

Page breaks  

To start a new chapter, section, part, volume, or book, use the page break function in your word-

processing software. In Microsoft Word, put your cursor before the text that should start on a 

new page (or wherever you want to insert a new page), then select Insert from the taskbar. Select 

Breaks from the menu that appears, then click the Page break option (see below) from Office 97 

– 2003.  

  

 

  

 

Note: Only use the “Page break” Break type option, not the “Section break types”  

  

When using this option, your section break and new chapter will appear like this:  
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When using later versions of Office (2007 and above) click Page Layout| Breaks | 

Odd/Next/Continuous Page. 

 
 

Punctuation  
  

Quotation marks  

Use curly/Smart quotation marks (“ ”) with no space after an opening mark or before a closing 

mark. Use straight/dumb quotation marks (" —type the usual apostrophes which will come out 

‘curly’ the press Ctrl key and Z for Undo) only for inch measurements. Similarly, single 

quotation marks (') should be used only to indicate measurements of feet and (‘’) to show 

quotations. If (“…”) are used for dialogue then (‘….’) should be used for quotes and vice-versa; 

and be consistent throughout the manuscript, don’t mix them.  

Spacing with punctuation  

Use just one space after all ending punctuation marks, including periods, question marks, 

exclamation points, and colons.  

Dashes and hyphens  

Do not insert spaces on either side of a dash or hyphen. Hyphens and both types of dashes should 

be flush with the text on either side.  

An em dash (—) is often used to denote a shift in thought that causes an abrupt change 

in a sentence. It can also be used to indicate a sudden break in dialogue.  

To enter an ‘em’ dash in Microsoft Word, simultaneously hold down the Ctrl and Alt 

keys while pressing the minus key on the number keypad. Or, hold down the Alt key 

while typing 0151 on the number keypad. 

Examples:  

• Eric—having just discovered the letter—ran down the street.  

• “Well, I don’t know,” he began tentatively. “I thought I might—”  

• Darkness, thunder, a sudden scream—nothing alarmed the child.  
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An en dash (–) is shorter than an em dash but longer than a hyphen. The principal use of 

the en dash is to connect continuing, or inclusive, numbers— dates, times, or reference 

numbers.  

To enter an en dash in Microsoft Word, hold down the Ctrl key while pressing the minus 

key on the number keypad. Or, hold down the Alt key while typing 0150 on the number 

keypad.  

Examples:  

• 1968–72  

• 10:00 AM–5:00 PM  

• 1 Cor 13:1–3  

A hyphen (-) is used to separate numbers that are not inclusive (such as phone numbers) 

as well as some compound words.  

Examples:  

• 1-965-386-1110  

• the well-known writer  

• anti-campaign  

The only time space should appear after a hyphen is when the second part of a compound 

word is repeated and can therefore be omitted.  

Examples:  

• five- to ten-minute intervals  

• the six- to nine-foot height   
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Additional Manuscript Elements  
  

Bulleted and numbered lists  

To create bulleted or numbered lists, use the bullets and numbering feature in word-processing 

program. In Microsoft Word, this feature is located under the Format menu taskbar. Be sure that 

each level of bullets or numbers is consistently indented or aligned.  

  

  
  

Illustrations, photos, and other graphics  

To better facilitate your submission process, we recommend that you minimize the file size of 

your manuscript as much as possible by providing each graphic in separate file. (Graphics 

include photos, charts, diagrams, drawings, art work, etc.) Each graphic file should be submitted 

in colour or grayscale, have a resolution of at least 300 dpi (dots per inch) and be PNG or JPEG 

(.jpg) format. In the manuscript, specify the file name and caption of each graphic in its correct 

location.  

  

Example  

  

My mother was born October 2, 1883, in Adair, Iowa. When she was ten years old, her 

family moved to Omaha, Nebraska. Her lineage linage traces back to England.  

  

<<{Insert graphic 2 – 3”x3”. Caption: Pictures of us at the airport>>  

 

  

Tables  

To insert tables, either with or without visible rules (or lines) use the table feature. In Microsoft 

Word, the Table menu is visible on your taskbar. Do not use the space bar or tabs to create 

tables; tables created this way don’t show as intended once the manuscript is reformatted to its 

final book form.  

  

Please Note:  We strongly recommend that you do not insert tables into your manuscript. 

However, if your manuscript requires there to be a table please also submit them 

separately as a graphic.   
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Footnotes and endnotes  

To properly create footnotes and endnotes, use the footnote or endnote feature in word-

processing program. Place the cursor in the text where you want to insert a footnote, then take 

the steps below. Under the Insert menu on your taskbar, select the Footnote option.  

  

 

  
  

  

b. On the box that pops up, select Footnote or Endnote, as appropriate and then click 

Options… to set the details of the note.  
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c. The numbering of footnotes and endnotes should start over in each chapter. If you have 

appropriately separated your chapters with section breaks, as outlined earlier, you can make sure 

your notes are numbered this way by selecting Restart each section.  

  

  
  

d. Once you have selected the appropriate system of numbering, click OK to insert the 

footnote or endnote into your manuscript. A superscript number will appear where your cursor is 

in the text, and a space will pop up at the bottom of the page to let you enter the text of the note.  
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In newer versions of Microsoft Word, first select the Reference option under the Insert menu; 

select Footnote from there or from References Menu in Office 2010/2013. 

 

 


